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Introducing ACCU-CHEK® Compass Diabetes Care 
Software

The Roche Diagnostics ACCU-CHEK® Compass Diabetes Care Software is a tool that 
helps you make better decisions through a clearer understanding of diabetes information. 
The ACCU-CHEK® Compass Diabetes Care Software (“this software”) enables you to:

� Transfer blood sugar results from a supported Roche blood sugar meter to your 
computer

� Import blood sugar results from ACCU-CHEK® Pocket Compass Diabetes Care 
Software and other Roche Diagnostics programs

� Add blood sugar results by hand

� Edit and delete your blood sugar results

� Display and print several types of reports and statistics

Note: Consult a doctor about using this software to help you manage your 
diabetes. Always ask a doctor when you have a question about your 
diabetes care plan.

Note: If you are moving from another Roche Diagnostics program, you can 
import patient information instead of adding it by hand. See “Sharing 
Information” on page 55 for details.

About this Guide

This guide is designed for people who are familiar with diabetes and the concepts relating 
to management of the disease. It contains information about using the commands and 
features. It assumes that you are familiar with Windows® and know how to use a mouse.

For information about system requirements and installing this software, see the Getting 
Started Guide.

Find additional information about this software at www.ACCU-CHEK.com. 

Note: In this guide, “blood sugar” has the same meaning as “blood glucose” (bG).
9



Contacting Roche Diagnostics

If you have trouble using the software, check the Help system or “Appendix A: 
Troubleshooting” on page 57. If you still cannot solve the problem, you can call Roche 
Diagnostics. 

� Call the Roche Diagnostics telephone number that is either on the back of the blood 
sugar meter or in the information that came with the meter.

Note: Roche Diagnostics does not recommend attempting to access or alter your 
database outside of the ACCU-CHEK® Compass Diabetes Care Software 
applications. Roche Diagnostics will not be liable for data manipulated 
outside of the ACCU-CHEK® Compass Diabetes Care Software 
application. Should you have questions regarding these statements, please 
contact your Roche representative.
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Getting Help

Using this software

Adding blood sugar results

Changing blood sugar results

To learn about this... ...read this section

� Starting this software “Starting ACCU-CHEK® Compass 
Diabetes Care Software” on page 13

� Using the Help system “Using the Help System” on page 14

� Using toolbar buttons “Using Buttons on the Toolbar” on page 15

� Using shortcuts “Using Shortcuts to Move Around” on 
page 16

� Using right-click menus “Using Right-click Menus to Move Around” 
on page 18

� Choosing a patient “Choosing Patients” on page 18

� Changing system options “Changing System Options” on page 19

� Backing up and restoring files “Protecting Your Information” on page 20

� Closing this software “Closing the ACCU-CHEK Compass 
Diabetes Care Software” on page 21

To learn about this... ...read this section

� Downloading blood sugar results from your 
meter

“Transferring Meter Results to Your 
Computer” on page 21

� Importing results from other software “Importing Files from ACCU-CHEK® 
Pocket Compass Software” on page 25 and 
“Importing Files from the Accutility and 
Camit Programs” on page 26

� Adding results by hand “Adding Blood Sugar Results Manually” on 
page 27

To learn about this... ...read this section

� Viewing results “Viewing Your Blood Sugar Results” on 
page 29

� Changing results “Changing Blood Sugar Results” on page 30

� Deleting results “Deleting Blood Sugar Results” on page 30
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Working with Reports

Patients

Meter lists for patients

To learn about this... ...read this section

� Choosing which report to view “Choosing a Report” on page 31

� Understanding the statistics “Understanding the Report Statistics” on 
page 32

� Average Day Report “The Average Day Report” on page 34

� Average Week Report “The Average Week Report” on page 36

� Hypoglycaemic Measurements Report “The Hypoglycaemic Measurements 
Report” on page 38

� Logbook Report “The Logbook Report” on page 39

� Target Range Report “The Target Range Report” on page 41

� Trend Graph Report “The Trend Graph Report” on page 43

� One Page Summary Report “The One Page Summary Report” on 
page 44

� Printing blank logbook pages “Printing Blank Logbooks” on page 45

� Saving custom reports “Working with Custom Reports” on page 46

To learn about this... ...read this section

� Choosing a patient “Choosing Patients” on page 18

� Adding a patient “Adding Patients” on page 46

� Viewing patient information “Viewing, Changing and Printing Patient 
Information” on page 47

� Changing patient information “Viewing, Changing and Printing Patient 
Information” on page 47

� Printing patient information “Viewing, Changing and Printing Patient 
Information” on page 47

� Deleting a patient “Deleting Patients” on page 49

To learn about this... ...read this section

� Adding a meter “Adding Meters” on page 49

� Deleting a meter “Deleting Meters” on page 50

� Changing the name of a meter “Changing Meter Names” on page 50
12



Setting up and clearing meters

Doctors

Additional resources

Starting ACCU-CHEK® Compass Diabetes Care 
Software

1 On the taskbar, click Start.

2 Point to Programs.

3 Point to ACCU-CHEK Compass.

4 Click ACCU-CHEK Compass.

-OR-

� Double-click the ACCU-CHEK Compass icon on your desktop. 

To learn about this... ...read this section

� ACCU-CHEK Complete meter setup “Setting Up Meters” on page 50

� Clearing meter memory “Clearing Meter Memory” on page 53

� Printing the meter setup “Printing Meter Setup” on page 54

To learn about this... ...read this section

� Viewing the doctor list “Viewing the Doctor List” on page 54

� Adding a doctor “Adding a doctor to the Doctor List” on 
page 54

� Changing doctor information “Changing contact information for a 
doctor” on page 54

� Deleting a doctor “Deleting a doctor from the Doctor List” on 
page 54

To learn about this... ...read this section

� Sharing Your Information “Sharing Information” on page 55

� Appendix A: Troubleshooting “Appendix A: Troubleshooting” on page 57

� Appendix B: Glossary “Appendix B: Glossary” on page 65

� Appendix C: About Time Blocks “Appendix C: About Time Blocks” on 
page 67
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Note: If more than one patient uses this software, the Patient List dialog box 
appears. Choose a patient from the list. For details, see “Choosing 
Patients” on page 18.

When you start this software the first time

A series of dialog boxes will help you add the first patient (for details, see “Adding Patients” 
on page 46). Be sure that you have the following information:

� The serial port (also called a “communications port” or “COM port”) to use for cable 
connections

� Blood sugar unit (mg/dL or mmol/L) to use when displaying blood sugar results

� Carbohydrate conversion used in the diabetes care plan (for details, see “Changing 
System Options” on page 19)

� The carbohydrate conversion that you choose must be the same as the carbohydrate 
conversion used by your meter. If the conversions are not the same, the results that 
you download from your meter will not show the correct value for carbohydrates.

You can also add and edit the following information using this software:

� Your address

� Patient ID

� Doctors who provide care

� Blood sugar target range

� Hypoglycaemic limit (also called the low blood sugar limit)

� Insulin types used

� Start times for each time block (see the “Appendix B: Glossary” on page 65)

� Workdays and non-workdays (see the “Appendix B: Glossary” on page 65)

Using the Help System

The Help system contains detailed information about using the ACCU-CHEK® Compass 
Diabetes Care Software commands and features. You can access the Help system in several 
ways: 
14



� Click Help in any dialog box.

� Press F1 to see a help topic for the active window, dialog box or report.

� Point to a command on any menu and press F1.

� Click  on the toolbar to view Help contents and index.

� Click Help on the menu bar to view Help contents and index and to see the version 
number of this software.

� Point to a button on the toolbar to see a brief description of the button.

Changing the font size of a Help topic

1 In the Help topic window, click Options.

2 Point to Font, and then click Small, Normal or Large.

Using Buttons on the Toolbar

The toolbar displays buttons that give quick access to frequently used commands.

 

Figure 1 The ACCU-CHEK® Compass Diabetes Care Software Toolbar

Click this button... ...to do this

Display the list of patients. 

Display patient information. 

Print the current report. 

Download meter results. For details, see “Transferring Meter Results 
to Your Computer” on page 21.
15



Showing/hiding the Toolbar 

� On the View menu, click Toolbar.

Using Shortcuts to Move Around 

The shortcuts on the Navigation Bar give you quick access to frequently used reports and 
commands.

Using shortcuts on the Navigation Bar

1 Click a group.

2 Click an icon. 

The shortcuts are arranged into the following groups:

� ACCU-CHEK Compass software

Displays shortcuts to four commands: display the Welcome window, download meter 
data, view blood sugar results and display the Web Links window.

� Standard Reports

Displays shortcuts to seven of the reports: One-Page Summary, Logbook, Trend 
Graph, Average Day, Average Week, Target Range and Hypoglycaemic Measurements.

� Custom Reports

Displays shortcuts to custom reports. Shortcuts to custom reports are automatically 
added to this group when you save a report using the Save as Custom Report 
command. For details, see “Working with Custom Reports” on page 46.

Set up a meter. For details, see “Setting Up Meters” on page 50.

Import blood sugar results. For details, see “Importing Files from 
ACCU-CHEK® Pocket Compass Software” on page 25.

Open the Help system.

Click this button... ...to do this
16



� My Shortcuts

Displays frequently used shortcuts that you can create and remove. For details, see 
“Creating a shortcut” on page 17.

Using Web Links

Note: You must have a working Internet account and a Web browser such as 
Netscape Navigator or Microsoft Internet Explorer installed on your 
computer.

1 On the Navigation Bar, click Web Links.

2 Click a link, which starts your browser and opens the selected link.

Showing/hiding the Navigation Bar

� On the View menu, click Navigation Bar. 

Creating a shortcut

Note: You can copy frequently used shortcuts from other groups and paste them 
into My Shortcuts. You can also remove the shortcuts in My Shortcuts. 

1 Right-click a shortcut in Compass, Standard Reports or Custom Reports.

2 Click Copy Shortcut.

3 Click My Shortcuts.

4 Right-click the location on the navigation bar where you want to place the shortcut 
for My Shortcuts.

5 Click Paste Shortcut.

Removing a shortcut

1 Right-click the shortcut that you want to remove from the navigation bar for My 
Shortcuts.

2 Click Remove Shortcut.
17



Using Right-click Menus to Move Around

Right-click menus give you a quick way of accomplishing tasks. The options on the right-
click menu vary and depend on where you are in the software. 

Using a right-click menu

� Using the right mouse button, click the item you want to work with (for example a 
blood sugar result in the Diary Data report). 

Examples of right-click menus:

� In the Diary Data report (Diary Data on the Personal menu), right-click a result to 
change or delete the result.

� In the Patient List (Patient List on the File menu), right-click the name of a patient to 
change the information for the patient or delete the patient.

� On the Navigation Bar, right-click an icon to copy it.

Choosing Patients 

Note: If more than one patient is using this software, you must choose one of the 
patients from the Patient List dialog box.

When you choose a patient from the Patient List dialog box, the patient record is opened. 
The record is automatically closed when you choose another patient or when you quit this 
software.

Choosing a patient

1 On the toolbar, click . 

2 Double-click a patient in the list or select the patient name and click Open. 

The title bar shows the name of the patient.

Tip: You can find a patient in the list by typing the last name of the 
patient in the Last Name box.
18



Changing System Options

You can change the following system options:

� Serial port to use for meter connections 

� Blood sugar (bG) unit 
� Carbohydrate conversion 
� Auto-Import path 

Changing System Options

� On the Tools menu, click System Options. 

Changing the Serial Port

� Click a serial port that is not in use by another serial device. 

For details, click Help.

Changing the Blood Sugar Unit

� Click the blood sugar (bG) unit that you want to use when displaying blood sugar 
results.

For details, click Help.

Note: If you do not know which unit to choose, check your meter for the unit used 
for blood sugar results or accept the default. You can change this option 
after asking a doctor which measurement unit to use. 

Changing the Carbohydrate Conversion 

CAUTION The carbohydrate conversion that you choose must be the same 
as the carbohydrate conversion used by your meter. If the 
conversions are not the same, the meter results that you 
download will not show the correct value for carbohydrates.

The carbohydrate conversion helps you understand your doctor’s instructions while using 
meal plan exchange lists. See the “Appendix B: Glossary” on page 65 for a definition of 
“carbohydrate”. See your doctor for details.
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� Click the carbohydrate conversion that is used by your meter.

For details, click Help.

Note: If the carbohydrate conversion that you need is not in the Carbohydrates 
area, add a custom carbohydrate conversion. For details, click Help. 

Notes about custom carbohydrate conversions:

� Conversion names can be up to 20 characters long and can be any combination of 
numbers and letters.

� Unit abbreviations can be up to four characters long and can be any combination of 
numbers and letters.

� You can change and delete only the carbohydrate conversions that you add.

Changing the Auto-Import Path

The Auto-Import path is the disk location of your Palm® directory. If you use ACCU-
CHEK® Pocket Compass Diabetes Care Software, your backup files are stored in this 
directory 
and are automatically imported into this software. For details, see “Importing Files from 
ACCU-CHEK® Pocket Compass Software” on page 25.

� Type a path in the text box.

-OR-

� Click Browse to search for the location of your Palm directory.

Protecting Your Information

To protect your information, we recommend that you back it up regularly. Backing up 
your files does not delete any information.

CAUTION When you restore a backup file, the current information is 
overwritten.
20
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Backing up files 

1 On the Tools menu, click Back Up Database.

2 If necessary, click a drive and directory in the Save in list of the Save As dialog box.

3 Click Save.

Restoring files 

1 On the Tools menu, click Restore Database.

2 If necessary, click a drive and directory in the Look in list of the Open dialog box.

3 Click Open.

Note: If the restore fails, current files are not overwritten.

Closing the ACCU-CHEK Compass Diabetes Care 
Software

� On the File menu, click Exit. 

-OR-

� Click the  in the upper right corner.

You are asked to back up all files.

Transferring Meter Results to Your Computer 

Note: In this guide, “transfer” has the same meaning as “download”.

Note: Refer to the Owner’s Manual that came with your ACCU-CHEK meter or 
device for additional details on transferring data.

There are several steps to transfer the results:

1 Connecting your meter to your computer.

2 Starting the transfer.

3 Correcting any problems with meter settings.



4 Correcting invalid results.

-OR-
Deleting invalid results.

5 [Optional] Reviewing the results.

6 [Optional] Changing the date and time of a result.

7 [Optional] Deleting a result.

8 [Optional] Printing the results.

9 Saving the results.

10 Cancelling the download.

Connecting your meter to your computer

1 Connect the meter cable to a 9-pin serial port connector on your computer. Refer to 
your cable insert for directions on how to connect the cable to your meter.

Starting the transfer

Note: During this step, the meter results are transferred to your computer, but 
they are not saved unless you specifically save them during Saving the 
results.

1 On the toolbar, click . 

2 Follow the instructions in the Prepare Meter dialog box. 

If your meter is not listed, follow the instructions that came with the meter.

Making sure the transfer works

� Always check to see that the meter cable is securely connected. A loose meter cable is 
one of the most common connection problems.

� Verify that the COM port is not in use by another program or serial device, such as a 
mouse, modem, digital camera, scanner, Palm® Pilot, PDA or other peripheral device.

� Verify that the battery in the meter is not weak or dead.

� Verify that the battery in the cable (if it has one) is not weak or dead.

� Verify that HotSync® is disabled.

� Close other running programs.
22



Correcting any problems with meter settings

� If the meter is not assigned to you

If the meter is not assigned to you, your patient record includes a meter list. You 
cannot download results from a meter that is not assigned to your meter list. To assign 
the meter, follow the instructions in the Unassigned Meter dialog box. For details, see 
“The “Unassigned Meter” dialog box appears” on page 58.

� If the meter settings are different from the settings in this software

If the meter settings are different from the settings in this software, you may be asked 
to match the settings. To correct differences, follow the instructions on the screen. For 
details, see “Communicating with the Meter” on page 58.

Correcting invalid results

If invalid results are detected, the Meter Data Review dialog box is displayed. Examples of 
invalid results are results without a date (month or day is zero) and results that are out of 
order by date or time.

CAUTION This software does not save invalid results.

1 In the Meter Data Review dialog box, click Go To Next Invalid Record.

2 Click Edit Record.

3 Type or select the new date, if needed.

4 Click the Time arrows to increase or decrease the value for the hours or minutes.

5 Click OK.

Note: If the date and time are not set, they need to be set in your meter. If the date 
and time are set correctly, click OK to save the result.

Deleting invalid results

CAUTION This software does not save invalid results.

1 In the Meter Data Review dialog box, click a result in the meter data list. 

2 Click Delete.

3 Click Yes to confirm the deletion.
23



[Optional] Reviewing the results

In the Download Summary dialog box, click Review. 

Recording insulin pump information

The following insulin pump information can be retrieved from some meters:

Bolus

Square wave bolus

Temporary basal

Ketone

HbA1C

The information is displayed in the Meter Data Review dialog box immediately after you 
download blood sugar results from a meter. You must print out a report to keep this 
information for the future. See “[Optional] Printing the results” on page 25.

[Optional] Changing the date and time of a result

1 In the Meter Data Review dialog box, click a result in the meter data list, and then 
click Edit Record. 

2 Type or select the new date.

3 To change the time, type or select the hours or minutes, and then click OK.

If Then

The Events and Miscellaneous column displays 
“Expired Strips”

These results may not be reliable. See the 
information provided with the meter.

The Events and Miscellaneous column displays 
“Low Battery”

The blood sugar measurement was taken when 
the meter was in a low battery state. See the 
information provided with the meter.

The Events and Miscellaneous column displays 
“Temperature”

The blood sugar measurement was taken at a 
temperature above or below the operational 
range of the test strips. See the information 
provided with the meter.

The Events and Miscellaneous column displays 
“Used Drum”

The blood sugar measurement was taken after 
the door was opened and closed with a partly 
used test drum inside, or a partly used test drum 
was inserted into the meter. These results may 
not be reliable. 
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[Optional] Deleting a result

1 In the Meter Data Review dialog box, click a result in the meter data list. 

2 Click Delete.

3 Click Yes to confirm the deletion.

[Optional] Printing the results

� In the Meter Data Review dialog box, click Print. 

Saving the results

1 In the Download Summary dialog box, click Save to keep the transferred results and 
store them in this software. 

2 If any of the results that you just transferred have the same time and date as existing 
results, the software displays the message, “Do you want these results to replace the 
existing ACCU-CHEK Compass Software results?”

� To save the results that you just transferred, click Yes.

� To save existing or edited results, click No.

Cancelling the download

� In the Download Summary dialog box, click Cancel. 

The meter results are deleted from your computer, but not from the meter. 

Importing Files from ACCU-CHEK® Pocket Compass 
Software

To import files from ACCU-CHEK® Pocket Compass Diabetes Care Software, you import 
the ACCU-CHEK Pocket Compass Software backup files stored on your desktop 
computer.

Using Auto-Import

1 Make sure that you have synchronised your most recent blood sugar results from the 
ACCU-CHEK® Pocket Compass Diabetes Care Software, as explained in the 
ACCU-CHEK Pocket Compass Software User’s Guide. 

2 Make sure that the Auto-Import path is pointing toward the location of your Palm 
directory. 
25



3 On the Tools menu, click Run Auto-Import.

-OR-

Exit and then restart this software. 
The ACCU-CHEK® Pocket Compass Diabetes Care Software files are imported 
automatically.

Checking the Auto-Import path

1 On the Tools menu, click System Options. 

2 If the path is not correct, type the correct path in the text box.

-OR-

Click Browse to search for the location of your Palm directory.

Tip: If Auto-Import does not import your file, try the instructions in 
“Importing the CEF file” on page 27.

Importing Files from the Accutility and Camit Programs

There are two steps to importing files from Accutility and Camit:

1 Converting your Accutility or Camit files to CEF format.

2 Importing the CEF file.

Converting your Accutility or Camit files to CEF format

You can use the Database Conversion Utility, which is included with this software, to create 
CEF files. Imported CEF files can contain information for one or more patients. 

1 On the Windows taskbar, click Start.

2 Point to Programs.

3 Point to ACCU-CHEK Compass.

4 Click ACCU-CHEK Compass Conversion Utility.

5 In the Input Folder box, enter the path to the program from which you want to 
convert data by typing the directory

-OR-

Click Browse.
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� For Camit S, the default directory is: C:\Camit_3

� For Camit for Windows, the default data directory is: C:\Camit\Data

� For Accutility, the default directory is: C:\Accutil

6 In the Output Folder box, enter the path for the output file by typing the directory

-OR-

Click Browse.

Note: A filename is assigned automatically based on the month and day, such as 
May_6.CEF. If the conversion utility reports that the output file already 
exists, delete or rename the current file.

7 Click Start to begin the conversion.

Note: An exchange factor is needed for the conversion of carbohydrate 
information from Camit S and Camit software for Windows. In the field 
provided, enter the number of grams per carbohydrate unit.

Importing the CEF file

1 Start the ACCU-CHEK® Compass Diabetes Care Software.

2 On the Tools menu, click Import Patient Data.

3 If necessary, click a device and directory in the Look in list of the Open dialog box.

4 Double-click the CEF file that you want to import.

5 Follow the instructions on the screen.

6 Review the information in the Import Summary window.

7 Click Continue to complete importing the files.

Adding Blood Sugar Results Manually 

You can manually add blood sugar results to your diary data. You must enter the date and 
time of the result. All other information is optional.
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Adding results manually

1 On the Personal menu, click Diary Data.

2 In Diary Data, click Add Record.

3 Type or select the date on which the blood sugar measurement was taken.

4 To change the time, select the hours or minutes, and then click the Time arrows.

5 Under bG, type or select the blood sugar result.

6 Click bG or one of the control solutions (see the “Appendix B: Glossary” on page 65 
for information about control solutions).

7 In the Time Block list, click the time block that best describes when you took the test 
relative to a meal. 

The time block you choose need not correspond to the time that you took the test. See 
the examples in “Choosing a Time Block” on page 28.

8 Under Insulin, type or select the doses for each type of insulin you used.

Note: You must choose insulin types before you can add insulin doses. See 
“Viewing, Changing and Printing Patient Information” on page 47.

9 Under Carbohydrates, type or select the number of units of carbohydrates that you 
ate.

10 Under Exercise, click the intensity and type

-OR-

Select the duration of exercise.

11 Under Events, click up to four events that occurred.

12 Click OK to add the blood sugar result to your Diary Data.

Choosing a Time Block

When choosing a time block, choose one that best describes when you took the blood sugar 
measurement with respect to a meal. (For an explanation of time blocks, see the “Appendix 
B: Glossary” on page 65.) The time block that you choose does not need to correspond to 
the actual time that the blood sugar measurement was taken. 
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For example:

� The Before Breakfast time block is between 6:30 A.M. and 8 A.M. You wake up at 
7 A.M. and take a blood sugar measurement before eating. Choose the Before 
Breakfast time block.

� The Before Breakfast time block is between 6:30 A.M. and 8 A.M. The After Breakfast 
time block is between 8 A.M. and 11 A.M. You wake up at 9 A.M. and take a blood 
sugar measurement before eating. Choose the Before Breakfast time block because 
the measurement was taken before eating breakfast.

Note: The names of time blocks used in this software are different from those used 
by ACCU-CHEK Complete meters. For details, see the “Appendix B: 
Glossary” on page 65. If you leave the time block blank, this software will 
assign a time block based first on meal-related events, if any, then on the 
time that the test was taken.

Viewing Your Blood Sugar Results

The Diary Data report displays blood sugar results. You can view all blood sugar results or 
a subset of results within a given time range. 

Viewing all blood sugar results

� On the Personal menu, click Diary Data.

The most recent information is shown at the top of the Diary Data report.

Viewing a subset of the blood sugar results

1 On the Personal menu, click Diary Data.

2 Click a time range in the Time Range list.

3 [Optional] Click Specific Date Range, then click the Calendar icon to choose a date 
range, and then type or select the start and end dates.

The start date must be before the end date.

Note: For details about the Events and Miscellaneous columns, see “In the 
Download Summary dialog box, click Review.” on page 24.
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Changing Blood Sugar Results 

Note: You cannot change the blood sugar measurement, time or date and you 
must choose insulin types before you can add insulin doses. See “Viewing, 
Changing and Printing Patient Information” on page 47.

Changing results and additional information

1 On the Personal menu, click Diary Data.

2 In Diary Data, click the blood sugar result you want to change.

3 Click Edit Record. 

You can change the following:

� Time blocks

� Insulin doses

� Carbohydrates

� Exercise

� Events

Note: For more information on time blocks, insulin doses, carbohydrates and 
events, see “Appendix B: Glossary” on page 65.

Deleting Blood Sugar Results

You can delete any blood sugar result, whether it was added manually, imported or 
downloaded from a meter. 

CAUTION When you delete blood sugar results, they are deleted 
permanently from your computer and cannot be retrieved.
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Deleting an individual result or sets of results

1 On the Personal menu, click Diary Data.

2 In Diary Data, click the blood sugar result you want to delete.

� If you want to delete more than one result, press and hold the CTRL key, then click 
each result that you want to select. 

� If you want to delete a group of results that are next to each other, click the first 
result, hold down the SHIFT key, then click the last result.

3 Click Delete Record.

4 Click Yes.

The record is deleted.

-OR-

Click No.

The Diary Data screen appears.

Choosing a Report 

Working with reports

� To show or hide the Report Settings dialog box, click Report Settings on the View 
menu.

� To show or hide the Report Legend, click Report Legend on the View menu.

� For details about the report statistics, see “Understanding the Report Statistics” on 
page 32.

 

Use this report… …to do this

Average Day View blood sugar results for each time block in a day. See “The Average 
Day Report” on page 34.

Average Week View blood sugar results for each day in a week. See “The Average Week 
Report” on page 36.

Hypoglycaemic 
Measurements

View blood sugar results and your hypoglycaemic limit. See “The 
Hypoglycaemic Measurements Report” on page 38.

Logbook View blood sugar results and insulin doses for each time block. See “The 
Logbook Report” on page 39.
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Understanding the Report Statistics 

Three columns of statistics are displayed at the bottom of each of the reports:

� Column 1 shows how the blood sugar results fall in relation to the target blood sugar 
range and hypoglycaemic limit.

� Column 2 shows the number of HIs and LOs.

� Column 3 shows the total number of blood sugar results, the average number of 
blood sugar results per day and the standard deviation.

The Average Day and Average Week reports have two additional rows of statistics:

� The upper row shows the number of tests in the corresponding time range (time 
block for Average Day and day of the week for Average Week). 

� The lower row shows the average bG (blood sugar) value in the time range. If no 
results are within a time range, the average is zero.

The following table explains what the labels mean. 

Target Range View blood sugar results and target ranges. See “The Target Range 
Report” on page 41.

Trend Graph View blood sugar trends. See “The Trend Graph Report” on page 43.

One Page Summary Combine graphs from other reports. See “The One Page Summary 
Report” on page 44.

Label Meaning

Range Your blood sugar targets.

Above Target Blood sugar results that fall above your upper blood sugar limit.

Within Target Blood sugar results that fall between your upper and lower blood sugar 
limits.

Below Target Blood sugar results that fall between your lower blood sugar and 
hypoglycaemic limits.

Hypo Blood sugar results that fall below your hypoglycaemic limit.

Tests The number of blood sugar results in the range.

Percent The percentage of blood sugar results in the range.

Highest bG The highest blood sugar result in the time range.

Lowest bG The lowest blood sugar result in the time range.

Use this report… …to do this
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Average bG The average blood sugar result in the time range.

Number of HIs The number of blood sugar results that were too great for the meter to 
measure.

Number of LOs The number of blood sugar results that were too low for the meter to 
measure.

Total # of Tests The number of blood sugar results in the time range.

Avg. # Tests per Day The average number of blood sugar results per day in the time range. 
This includes all days, whether any tests were run on the day or not.

Standard Deviation Shows how tightly your blood sugar results are clustered around the 
mean (average) blood sugar result. When the standard deviation is 
small, your results have values that are close together. When the 
standard deviation is large, your results have values that are spread far 
apart. Your doctor sets the standard deviation goal for you.

Label Meaning
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The Average Day Report

The Average Day Report displays the average blood sugar result for each time block for the 
current time range. The report can display results in the blood sugar measurement unit of 
your choice. See “Changing System Options” on page 19. The table below explains the 
symbols and their meanings. 

Figure 2 Average Day Report

Symbol Meaning

Target bG Range. The shading shows the area of the graph that is between the 
low blood sugar limit and the high blood sugar limit.

Hypo bG Limit. The line shows the limit where you have too little sugar in the 
blood.

Average. The point shows the average blood sugar result.
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Viewing blood sugar results for each time block in a day

1 On the Reports menu, click Average Day.

2 In the Report Settings dialog box

Click the Time Range arrow to choose the time range for the results you want to view.

-OR-

To choose a specific time range, click Specific Date Range, and then click the Calendar 
icon. 

3 Click a start date and end date.

4 Click OK.

5 Under Show, click one of the following:

Individual measurements to display each blood sugar result on the report.

-OR-

Range to display the range between the low and high result as a bar on the report.

6 In the Measurements from list, click the days of the week for which you want the 
blood sugar results to be displayed.

Note: The names of time blocks used in this software are different from those used 
by ACCU-CHEK Complete meters. For details, see the “Appendix B: 
Glossary” on page 65. See “Understanding the Report Statistics” on 
page 32 for an explanation of the statistics.

Printing the report

� On the toolbar, click . 

Note: If your computer has a fax print driver, you may be able to fax reports from 
this software. See your fax or computer documentation for instructions.

Range. The bar shows the range between the highest and lowest blood sugar 
results, not including HIs or LOs.

-OR-
bG Measurement. The small square shows the value of the blood sugar result.

Symbol Meaning
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The Average Week Report

The Average Week Report displays the average blood sugar result for each day in a week for 
the current time range. The report can display results in the blood sugar measurement unit 
of your choice. See “Changing System Options” on page 19. The table below explains the 
symbols and their meanings.

Figure 3 Average Week Report

Symbol Meaning

Target bG Range. The shading shows the area of the graph that is between the 
low blood sugar limit and the high blood sugar limit.

Hypo bG Limit. The line shows the limit where you have too little sugar in the 
blood.

Average. The point shows the average blood sugar result.
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Viewing blood sugar results for each day in a week

1 On the Reports menu, click Average Week.

2 In the Report Settings dialog box

Click the Time Range arrow to choose the time range for the results you want to view.

-OR-

Choose a specific time range by clicking Specific Date Range, clicking the Calendar 
icon, clicking a start date and end date, clicking OK.

3 Under Show, click one of the following:

Individual measurements to display each blood sugar result on the report.

-OR-

Range to display the range between the low and high result as a bar on the report.

Note: See “Understanding the Report Statistics” on page 32 for an explanation 
of the statistics.

Printing the report

� On the toolbar, click . 

Note: If your computer has a fax print driver, you may be able to fax reports from 
this software. See your fax or computer documentation for instructions.

Range. The bar shows the range between the highest and lowest blood sugar 
results, not including HIs or LOs.

-OR-
bG Measurement. The small square shows the value of the blood sugar result.

Symbol Meaning
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The Hypoglycaemic Measurements Report

The Hypoglycaemic Measurements Report displays the percentage of blood sugar results 
that fall below the hypoglycaemic (low blood sugar) limit. 

Viewing the Hypoglycaemic Measurements report

1 On the Reports menu, click Hypoglycaemic Measurements.

2 In the Report Settings dialog box

Click the Time Range arrow to choose the time range for the results you want to view.

-OR-

Choose a specific time range by clicking Specific Date Range, clicking the Calendar 
icon, clicking a start date and end date, clicking OK.

Figure 4 Hypoglycaemic Measurements Report
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CAUTION Consult your health care professional to determine the 
hypoglycaemic limit that best compliments your therapy. DO 
NOT use the hypoglycaemic limit as the only indicator of 
hypoglycaemia. Always rely upon your symptoms and 
instructions from your health care professional.

Note: The names of time blocks used in this software are different from those used 
by ACCU-CHEK Complete meters. For details, see the “Appendix B: 
Glossary” on page 65. See “Understanding the Report Statistics” on 
page 32 for an explanation of the statistics.

Printing the report

� On the toolbar, click . 

Note: If your computer has a fax print driver, you may be able to fax reports from 
this software. See your fax or computer documentation for instructions.

The Logbook Report

The Logbook report displays blood sugar results and insulin doses for each time block in 
the diabetes care plan for the current time range. The report has a format similar to the 
Self-Test Diary booklets that are supplied with a meter. You can set the time range for the 
results you want to view, such as the past 7 days or the past 14 days.

� Results above your upper blood sugar limit appear in bold text.

� Results at or above the hypoglycaemic limit but below your lower blood sugar limit 
appear in bold text.
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� Results below your hypoglycaemic limit appear in bold, red text.

Viewing the Logbook report

1 On the Reports menu, click Logbook.

2 In the Report Settings dialog box

Click the Time Range arrow to choose the time range for the results you want to view.

-OR-

Choose a specific time range by clicking Specific Date Range, clicking the Calendar 
icon, clicking a start date and end date, clicking OK.

Printing the report

� On the toolbar, click . 

Note: If your computer has a fax print driver, you may be able to fax reports from 
this software. See your fax or computer documentation for instructions.

Figure 5 Logbook Report
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The Target Range Report

The Target Range Report displays the percentage of blood sugar results that fall outside the 
target blood sugar range and below the hypoglycaemic (low blood sugar) limit. 

Viewing blood sugar results and target ranges

1 On the Reports menu, click Target Range.

2 In the Report Settings dialog box

Click the Time Range arrow to choose the time range for the results you want to view.

-OR-

Choose a specific time range by clicking Specific Date Range, clicking the Calendar 
icon, clicking a start date and end date, clicking OK.

3 In the Compare list, click the comparison that you want.

Figure 6 Target Range Report
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Note: The Overall graph includes all blood sugar results within the specified time 
range. See “Understanding the Report Statistics” on page 32 for an 
explanation of the statistics.

Printing the report

� On the toolbar, click . 

Note: If your computer has a fax print driver, you may be able to fax reports from 
this software. See your fax or computer documentation for instructions.
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The Trend Graph Report

The Trend Graph Report displays blood sugar trends for each day for the current time 
range. The table following the graph explains the symbols and their meanings.

Figure 7 Trend Graph Report

Symbol Meaning

Target bG Range. The shading shows the area of the graph that is between the 
low blood sugar limit and the high blood sugar limit.

Hypo bG Limit. The line shows the limit where you have too little sugar in the 
blood.

Average. The point shows the average blood sugar result.

Range. The bar shows the range between the highest and lowest blood sugar 
results, not including HIs or LOs.

-OR-
bG Measurement. The small square shows the value of the blood sugar result.
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Viewing the blood sugar trends report

1 On the Reports menu, click Trend Graph. 

2 In the Report Settings dialog box

Click the Time Range arrow to choose the time range for the results you want to view.

-OR-

Choose a specific time range by clicking Specific Date Range, clicking the Calendar 
icon, clicking a start date and end date, clicking OK.

3 Under Show, click one of the following:

� Individual measurements to display each blood sugar result on the report.

� Range to display the range between the low and high result as a bar on the report.

Note: See “Understanding the Report Statistics” on page 32 for an explanation 
of the statistics.

Printing the report

� On the toolbar, click . 

Note: If your computer has a fax print driver, you may be able to fax reports from 
this software. See your fax or computer documentation for instructions.

The One Page Summary Report

The One Page Summary report combines graphs from up to three reports. 

Combining graphs from other reports

1 On the Reports menu, click One-Page Summary.

2 In the Report Settings dialog box

Click the Time Range arrow to choose the time range for the results you want to view.

-OR-

Choose a specific time range by clicking Specific Date Range, clicking the Calendar 
icon, clicking a start date and end date, clicking OK.
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The time range you choose is used for all graphs on the One Page Summary Report.

3 Click the Graph 1 tab. 

4 In the Available Graphs list, click the first report that you want to include in the 
summary report.

5 Choose the settings for the first report.

6 Click the Graph 2 tab. 

7 In the Available Graphs list, click the second report that you want to include in the 
summary report.

8 Choose the settings for the second report.

9 Click the Graph 3 tab. 

10 In the Available Graphs list, click the third report that you want to include in the 
summary report.

11 Choose the settings for the third report.

Printing the report

� On the toolbar, click . 

Note: If your computer has a fax print driver, you may be able to fax reports from 
this software. See your fax or computer documentation for instructions.

Printing Blank Logbooks

Blank logbooks enable you to keep a hand written record of insulin doses and blood sugar 
results. Each page has room for 4 weeks of information. Print these pages to supplement 
the logbook that came with the meter.

� On the Tools menu, click Print Blank Logbook. 
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Working with Custom Reports

Saving a custom report 

1 On the Reports menu, click the type of report that you want to save.

2 In the Report Settings dialog box, click the time period for the report.

3 Choose other report settings.

4 On the Reports menu, click Save As Custom Report.

5 Type a name for the report in the Report Name box.

6 Click OK. 

A shortcut for the report is stored in the Custom Reports group on the Navigation 
Bar (see “Using Shortcuts to Move Around” on page 16). The report name is also 
added to the Save As Custom Report command on the Reports menu.

Viewing a custom report

1 Click Custom Reports on the Navigation Bar.

2 Click the shortcut to the report that you want to open.

Deleting a custom report

1 Click Custom Reports on the Navigation Bar.

2 Right-click the shortcut to the report. 

3 Click Delete Custom Report. 

The report and all references to it are deleted. References include the shortcut to the 
report in Custom Reports on the Navigation Bar (see “Using Shortcuts to Move 
Around” on page 16), any shortcut to the report that is in My Shortcuts and the 
report name in the Save As Custom Report command on the Reports menu.

Adding Patients 

This software creates a patient record whenever you add a patient. Patient records can 
contain your name, address, date of birth, patient ID, doctor names with contact 
information and diabetes care plan.
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Adding a patient

1 On the toolbar, click .

2 Click Add. 

3 Type the contact information for you and your doctor, then click Next.

Note: Only your first name, last name and date of birth are required.

4 [Optional] Type or select the blood sugar targets, then click Next. 

5 [Optional] Click the insulin types, then click Next. 

6 [Optional] Type or select the start time for each time block; click Work Day or Non-
Work Day for each day of the week; and then click Next.

7 [Optional] Double-click events in the Available Events list that you might want to 
note about health or activities. 

You can include up to fifteen events in the ACCU-CHEK Compass Events list (see the 
“Appendix B: Glossary” on page 65). 

Note: If the events you choose are different from those in the meter, the next time 
you connect the meter, the software prompts you to match events. 

8 To exit the Add Patient dialog box, click Finish.

Note: To print the information that you added, click Print in the Add Patient 
dialog box.

Viewing, Changing and Printing Patient Information

Viewing patient information

� On the toolbar, click .
47



Changing patient information

� For details, click Help on any of the tabs in the Patient Information dialog box. 
 

Note: If the meter is an ACCU-CHEK Complete Meter and you set up the meter 
from this software, choosing insulin types from the Insulin tab turns on the 
insulin logging features in your meter.

Adding a doctor to your doctor list 

1 On the General tab, click Add.

2 Click one of the doctors’ names in the Doctor List, then click OK.

Note: If the desired doctor is not on the list, you can add a new doctor to the list 
by clicking Add. See “Adding a doctor to the Doctor List” on page 54.

Deleting a doctor from your doctor list 

1 On the General tab, click a name in the Doctor List.

2 Click Delete.

Printing your patient information

� On the File menu, click Print Patient Information. 

To change this... ...click this tab

Your contact information or your doctor list General

Upper blood sugar, lower blood sugar and hypoglycaemic limits Targets

Insulin types and abbreviations Insulin

Time blocks, workdays and non-workdays Time Blocks

Events to choose from Events

Meters that you use Meters
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Deleting Patients

CAUTION Deleting a patient permanently removes all information about 
the patient, including blood sugar results.

Deleting a patient

1 On the toolbar, click . 

2 Click a patient in the list and then click Delete.

Adding Meters

Each patient record includes a meter list. You can add up to three meters to your meter list. 
You must choose a name for each meter that you add, and the name must be different from 
any other name on your list.

Adding a Meter to Your Meter List

Note: Choose a meter name that is useful, such as “Office meter” or “Home 
meter”.

1 Connect the meter cable to a 9-pin serial port connector on the computer.

2 On the toolbar, click . 

3 Click the Meters tab.

4 Click Add.

5 Follow the instructions on the screen. 

Meter names can be up to 40 characters long and can be any combination of numbers 
and letters.

Note: If the meter settings are different from the settings in this software, you may 
be asked to match the settings. To correct differences, follow the instructions 
on the screen. For details, see “Communicating with the Meter” on 
page 58.
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Deleting Meters

Deleting a Meter from Your Meter List

1 On the toolbar, click . 

2 Click the Meters tab.

3 Click the meter name that you want to delete.

4 Click Delete.

Changing Meter Names

Changing the Name of a Meter

1 On the toolbar, click .     

2 Click the Meters tab.

3 Double-click the meter name that you want to change.

4 Type the new name in the Meter Name box, and then click OK.

Setting Up Meters

Setting Up an ACCU-CHEK Complete Meter

You can use this software to set up any of these ACCU-CHEK Complete meters: 

� ACCU-CHEK Complete

� ACCU-CHEK Sensor Complete

� Accutrend Sensor Complete

� Advantage Complete

� AccuSoft Advantage Complete

Setup information includes your diary defaults, language, time and date formats, insulin 
pump profiles and tip messages. 
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Note: For any option that you do not change, the default option is sent to the 
meter.

There are several steps to setting up your meter:

1 Getting started

2 Choosing language and formatting options

3 Adding, changing or deleting insulin pump information

4 Adding tip messages or turn off tip messages

5 Changing your Diary defaults

6 Sending the setup to the meter

Getting started

1 On the toolbar, click . 

2 In the Select Meter Setup dialog box, click the ACCU-CHEK Complete meter group, 
and then click OK.

Choosing language and formatting options

1 From the Meter Setup dialog box, click the General tab. 

2 Click the options that you prefer.

Adding, changing or deleting insulin pump information 

1 From the Meter Setup dialog box, click the Insulin Pump tab.

2 Select the Pump Logging check box.

3 Click a Profile tab and then enter the information. 

You can create up to four profiles. For details, click Help.

Note: Insulin pump time blocks are not related to the time blocks described in the 
“Appendix B: Glossary” on page 65.

4 In the Active Profile list, click the profile that you want to send to the meter.
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Adding tip messages or turn off tip messages   

� From the Meter Setup dialog box, click the Tips tab. 

For details, click Help. 

Note: You must select exactly 10 tips.

Changing your Diary defaults

The Diary includes insulin doses, exercise, carbohydrates and events for each time block. 
You can save time if you set up the default diabetes care plan for your needs. When you take 
a blood sugar measurement, the defaults for the appropriate time block can be added to the 
meter result. 

� From the Meter Setup dialog box, click the Diary Defaults tab, and then enter 
information for each time block. For details, click Help. 

Note: The names of time blocks used in this software are different from those used 
by ACCU-CHEK Complete meters. For details, see the “Appendix B: 
Glossary” on page 65.

Sending the setup to the meter 

Note: You can also set up a meter manually. To do so, see the information 
supplied with the meter. 

1 Connect the meter cable to a 9-pin serial port connector on the computer.

2 Click Send Setup to Meter.

3 Follow the instructions on the screen.

Note: If the meter settings are different from the settings in this software, you may 
be asked to match the settings. To correct differences, follow the instructions 
on the screen. For details, see “Communicating with the Meter” on 
page 58.
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Tip: To print the setup options, click Print.

Clearing Meter Memory

Clearing the Memory in a Meter

CAUTION We recommend that you download meter results before 
clearing the meter memory. The results cannot be retrieved 
once the meter memory is cleared.

1 Connect the meter cable to a 9-pin serial port connector on the computer.

2 On the Meter menu, click Clear Meter Memory. 

3 Follow the instructions on the Prepare Meter dialog box. 

If your meter does not appear on this list, follow the instructions that came with the 
meter.

� If the meter is not assigned to you

If the meter is not assigned to you, your patient record includes a meter list. You 
cannot clear the memory of a meter that is not assigned to your meter list. To 
assign the meter, follow the instructions in the Unassigned Meter dialog box. For 
details, see “The “Unassigned Meter” dialog box appears” on page 58.

� If the meter settings are different from the settings in this software

If the meter settings are different from the settings in this software, you may be 
asked to match the settings. To correct differences, follow the instructions on the 
screen. For details, see “Communicating with the Meter” on page 58.
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Printing Meter Setup

Printing a Meter Setup Report

You can print a Meter Setup Report without connecting the meter to your computer. 

� On the Meter menu, click Print Meter Setup.

Viewing, Adding, Changing and Deleting Doctor 
Information

This software uses the Doctor List to list doctors and their contact information. 

Note: Read this section if you want to store information about doctors in this 
software.

Viewing the Doctor List

� On the File menu, click Doctor List. 

Adding a doctor to the Doctor List

1 On the File menu, click Doctor List. 

2 Click Add.

3 Type the contact information, then click OK.

Changing contact information for a doctor

1 On the File menu, click Doctor List. 

2 Click the doctor in the list, then click Edit.

3 Change the contact information, then click OK.

Deleting a doctor from the Doctor List

1 On the File menu, click Doctor List.     

2 Click a doctor in the list, then click Delete.
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Note: If you delete a doctor from the Doctor List, the doctor is removed from all 
patients’ doctor lists.

Sharing Information

Exporting information

Exporting your information is helpful because it enables you to:

� Share information with health care professionals using Compass Software or Camit 
Pro Software.

� Analyse information in other programs, such as Microsoft Excel.

You can export Camit Export Format (CEF) and Comma-Separated Values (CSV) files 
from this software, but you can import only CEF files into this software. 

Note: The ACCU-CHEK® Compass Diabetes Care Software exports the 
following CSV format: ASCII (or plain text) with commas separating 
values, full stops acting as decimal separators and double quotation marks 
surrounding alphanumeric characters. This CSV format might not be the 
same as CSV formats used outside of the United States.

You can export only one patient per CEF or CSV file. You can choose the date range to be 
exported. CSV files are exported using the measurement units chosen in the System 
Options dialog box (see “Changing System Options” on page 19). To open an exported file 
with a third party program, such as Microsoft Excel, you must choose CSV format.
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Exporting files

Note: Blood sugar results are exported in bG units set up in this software. You can 
configure this software to utilise the bG units you prefer. See “Changing 
System Options” on page 19. 

1 On the Tools menu, click Export Patient Data.

2 If necessary, click a device and directory in the Save in list of the Save As dialog box.

3 In the File name box, type a name for the file into which you want the patient 
information saved.

4 In the Files of type list, 

Click CEF 

-OR-

Click CSV

5 In the Data to Save list 

Click All Records

-OR-

Click Past 30 Days

-OR-

Click Specific Date Range

Note: If you click Specific Date Range, click the Calendar icon to choose a date 
range, and then type or select the start and end dates. The start date must 
be before the end date.
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Appendix A: Troubleshooting

Each section lists potential problems and solutions. If you cannot find the solution to your 
problem, contact Roche Diagnostics (see “Contacting Roche Diagnostics” on page 10).

Starting the ACCU-CHEK Compass Diabetes Care Software

Problem Solution

The ACCU-CHEK® 
Compass Diabetes Care 
Software does not start

1 You may already have this software running. If so, click 
its icon on the task bar.

2 Close all other programs and try again.

3 Reboot your system and try again.

4 On the taskbar, click the Start button, point to 
Programs, point to ACCU-CHEK Compass, and then 
click ACCU-CHEK Compass.

If this software starts, delete your shortcut and create a 
new shortcut.

-OR-

If the software does not start, uninstall the 
ACCU-CHEK® Compass Diabetes Care Software. Then 
reinstall it. (Click Yes when asked about keeping current 
data files).

The ACCU-CHEK® 
Compass Diabetes Care 
Software starts but the 
buttons are not visible or 
the screen is distorted

� Set the display resolution on your personal computer 
monitor to 800 x 600 or higher with at least 256 colours.

� Set the Windows font size to Small Fonts.

� Set Scheme to Windows Standard.

You cannot find a 
patient’s name in the 
Patient List

1 Enter the patient’s last name into the Last Name box.

2 Scroll through the Patient List to check for alternative 
spellings.

3 Add the patient.
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Communicating with the Meter

Problem Solution

You are unable to 
communicate with 
the meter

� Always check to see that the meter cable is securely 
connected. A loose meter cable is one of the most 
common connection problems.

� Verify that the COM port is not in use by another 
program or serial device, such as a mouse, modem, 
digital camera, scanner, Palm Pilot, other PDA or 
peripheral device.

� Verify that the battery in the meter is not weak or dead.

� Verify that the battery in the cable (if it has one) is not 
weak or dead.

� Verify that HotSync® is disabled.

� Close other running programs.

The “Unassigned Meter” 
dialog box appears

The meter is not assigned to you. Either assign the meter or 
cancel the download. 

To assign the meter:

� Click Add Meter. Meter names can be up to 40 
characters long and can be any combination of numbers 
and letters.

To cancel the download:

� Click Cancel.

The meter’s time blocks 
do not match this 
software’s time blocks

Review both sets of time blocks and do one of the following:

� Change both sets of time blocks.

Click Cancel and then click Patient Information on the 
File menu to change the settings.

-OR-

� Use the meter’s time blocks.

Click Change ACCU-CHEK Compass to These Settings.

-OR-

� Use this software’s time blocks.

Click Change Meter to These Settings.
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The meter’s insulin types 
do not match this 
software’s insulin types

Review both sets of insulin types and do one of the following:

� Change both sets of insulin types.

Click Cancel. Then, click Patient Information on the 
File menu to change the settings.

-OR-

� Use the meter’s insulin types.

Click Change ACCU-CHEK Compass to These Settings.

-OR-

� Use this software’s insulin types.

Click Change Meter to These Settings.

The meter’s blood sugar 
targets do not match this 
software’s blood sugar 
targets

Review both sets of blood sugar targets and do one of the 
following:

� Change both sets of blood sugar targets.

Click Cancel and then click Patient Information on the 
File menu to change the settings.

-OR-

� Use the meter’s targets.

Click Change ACCU-CHEK Compass to These Settings.

-OR-

� Use this software’s targets.

Click Change Meter to These Settings.

Problem Solution
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The meter’s 
hypoglycaemia target 
does not match this 
software’s hypoglycaemia 
target

Review both targets and do one of the following:

� Change both targets.

Click Cancel and then click Patient Information on the 
File menu to change the settings.

-OR-

� Use the meter’s target.

Click Change ACCU-CHEK Compass to This Setting.

-OR-

� Use this software’s target.

Click Change Meter to This Setting.

The meter’s events do 
not match this software’s 
events

Note: Events must be identical and listed in the 
same order.

Review both sets of events and do one of the following:

� Change both sets of events.

Click Cancel and then click Patient Information on the 
File menu to change the settings.

-OR-

� Use the meter’s events.

Click Change ACCU-CHEK Compass to These Settings.

-OR-

� Use this software’s events.

Click Change Meter to These Settings.

Problem Solution
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Viewing Reports

The meter’s date and 
time do not match this 
software’s date and time

Look at the meter’s date and time and your computer’s date 
and time.

� To change your meter’s date and time to agree with your 
computer’s date and time, click Yes.

� To leave the date and time as is, click No.

� To change the date and time:

1 Click Cancel.

2 Exit this software.

3 Change the time and date setting on the computer.

4 Restart this software.

5 Start the meter download again.

Problem Solution

Your reports show 
missing, incorrect or no 
information

� If possible, scroll the report window to see the rest of the 
report.

� Check your report settings, such as the date range.

� Verify that you are looking at the correct patient 
information.

� Check to see if the missing results are marked as controls 
or have events assigned to them, such as Other’s Result 
or Invalid Test.

Any of the conditions above will stop the results from 
appearing on reports. If the events are not correct, remove 
them. If the events are correct, the results should not appear 
on the report.

� The results may have been deleted.

� Download your meter to see if the results are still there. 
If the meter was cleared prior to its download, the results 
are not recoverable.

Problem Solution
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Printing

Note: If your computer has a fax print driver, you may be able to fax reports from 
this software. See your fax or computer documentation for instructions.

Problem Solution

You cannot print from 
the ACCU-CHEK® 
Compass Diabetes Care 
Software

� Verify that your printer is turned on.

� Verify that your printer is online.

� Verify that the printer cables are connected.

� Verify that your printer has paper.

� Verify that your printer has ink (toner or cartridge).

� Verify that the proper printer is listed under Printers in 
Windows.

� Verify that you chose the correct printer.

� Print a test page from the printer properties page in 
Windows. If this does not work, see Troubleshooting in 
Windows Help.

Your printed reports are 
distorted or missing 
information

� Print a test page from the printer properties page in 
Windows. If this does not work, see Troubleshooting in 
Windows Help.

� Check that your printer has ink (toner or cartridge).

� Some reports look better in portrait than landscape, so 
try portrait.
62



Importing Patient Files

Connecting to the Internet

Problem Solution

The ACCU-CHEK® 
Compass Diabetes Care 
Software cannot locate a 
patient in the CEF file

Do one of the following:

� Click a patient in the Patient List and click Add to 
Patient. 

This option closes the dialog box and adds the Pending 
Patient information to the patient selected in the Patient 
List.

-OR-

� Click Create New Patient. 

This option closes the dialog box, creates a new patient 
using the Pending Patient information and stores the 
information with the new patient.

-OR-

� Click Skip Patient. 

This option closes the dialog box and discards the 
Pending Patient’s information.

-OR-

� Click Cancel. 

This option closes the dialog box, discards the Pending 
Patient’s information and cancels the import process.

Problem Solution

You cannot connect to 
the Internet

� Verify that the modem is installed and correctly 
configured. See the information that came with your 
modem.

� Verify that you have an Internet account through an 
online service -- such as America Online (AOL) or an 
alternative Internet service provider (ISP).

� Verify that your Internet browser starts directly from the 
desktop. If your browser starts, then retry the Web link 
within this software.
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Appendix B: Glossary

Term Definition

bG Abbreviation for “blood glucose” or “blood sugar”.

Blood Glucose See “blood sugar”.

Blood Sugar The food a person eats is broken down into glucose by the body. The cells in the 
body use glucose for energy. The amount of glucose in the blood is called the 
blood sugar level. To stay healthy, people with diabetes need to keep their blood 
sugar levels between the high and low limits advised by their doctors.

Blood sugar is also referred to as “blood glucose”.

Blood Sugar 
Targets

A diabetes care plan typically includes blood sugar targets, which are specified 
by your doctor. The targets include an upper limit, a lower limit and a 
hypoglycaemic limit. To stay healthy, people with diabetes need to keep their 
blood sugar levels between the high and low limits advised by their doctors.

To set targets, click Patient Information on the File menu and then click the 
Targets tab.

Carbohydrate The chemical compounds that are a body’s preferred and main source of fuel 
or energy. The body eventually breaks down all carbohydrates into glucose.

Diary Data The Diary Data report shows a table of blood sugar test results together with 
associated data including insulin, carbohydrates, exercise and events. You can 
use the Diary Data report to: add a blood sugar result, change a blood sugar 
result, delete a blood sugar result from your Diary Data or add associated 
information to an existing blood sugar result.

To open the Diary Data report, click Diary Data on the Personal menu.

Events Events describe your condition or activity, for example “feeling hypo”, “snack” 
or “bed time”. Events enable you to record additional information associated 
with a blood glucose result that is relevant to diabetes management. To change 
the available events, click Patient Information on the File menu and then click 
the Events tab.

Hypoglycaemia Too little glucose in the blood. Also called “low blood sugar” or “low blood 
glucose”.

Hypoglycaemic 
Limit

A diabetes care plan typically includes blood sugar targets, which are specified 
by a doctor. The targets include a hypoglycaemic limit. The hypoglycaemic 
limit indicates a state in which a patient has too little sugar in the blood. This 
can lead to patients feeling light-headed, shaky and sweaty. To stay healthy, 
people with diabetes need to keep blood sugar levels above the hypoglycaemic 
limit advised by their doctors. To set the hypoglycaemic limit, click Patient 
Information on the File menu and then click the Targets tab.

Insulin Insulin is the hormone that enables a person’s body to use glucose for energy. 
Some people with diabetes must take insulin because their bodies do not 
manufacture enough of it or use it properly. Insulin types and doses are 
prescribed by a doctor.
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Logbook 
Report

The Logbook report shows blood sugar test results and insulin doses in relation 
to time blocks. The report shows results in a format similar to the Self-Test 
Diary booklets that are supplied with a meter.

To open the Logbook Report, click Logbook on the Reports menu.

Time Blocks A time block is a period of time during which specific events occur, such as 
blood sugar tests, taking medicine or exercise. A diabetes regimen is composed 
of time blocks. The start and end times for time blocks vary from patient to 
patient, but are generally tied to patient meal times. In this software, eight time 
blocks cover a 24-hour period.

To change the time block start times, click Patient Information on the File 
menu.

Two sets of time block names are used—those used by this software and the 
corresponding names used by ACCU-CHEK Complete meters. See 
“Appendix C: About Time Blocks” on page 67.

Workdays and 
Non-Workdays

Patient schedules, exercise routines and eating habits might differ between 
workdays and non-workdays. If you classify each day as either a workday or 
non-workday, you can compare the blood sugar results for each grouping by 
viewing the Target Range report. This comparison might help you make better 
decisions regarding the diabetes care plan. (For details, see “The Target Range 
Report” on page 41).

Term Definition
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Appendix C: About Time Blocks

Comparison of time block names

The table below provides a comparison of time block names used by this software and 
ACCU-CHEK Complete Meters.

:

When adding a patient, you can enter a start time for each ACCU-CHEK® Compass 
Diabetes Care Software time block or use the defaults.

Note: End times are calculated and displayed automatically.

Examples of Time Blocks

If you are awake during the day and sleep at night, these start times for the time blocks 
might be suitable:

The ACCU-CHEK Compass Diabetes Care 
Software Time Block Names

ACCU-CHEK Complete Meter Time Block 
Names

Night (Nt) Nighttime (Ngt)

Before Breakfast (BB) Breakfast (Brk)

After Breakfast (AB) Mid-morning (Mmo)

Before Lunch (BL) Lunch (Lun)

After Lunch (AL) Mid-afternoon (Maf)

Before Dinner (BD) Dinner (Din)

After Dinner (AD) Evening (Eve)

Evening (Ev) Bedtime (Bed)

Night 12 A.M.

Before Breakfast 6:30 A.M.

After Breakfast 8 A.M.

Before Lunch 11 A.M.

After Lunch 12:30 P.M.

Before Dinner 5 P.M.

After Dinner 6:30 P.M.

Evening 9:30 P.M.
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If you start work at midnight, these start times might be suitable:

Note: Time Block start times can be changed when your schedule changes. Time 
Blocks are assigned to blood sugar results when the results are saved in this 
software. 

You can compare blood sugar results for time blocks by viewing the Average Day, Target 
Range and Hypoglycaemic Measurements Reports. These comparisons might help you 
make better decisions regarding your diabetes care plan.

Night 4 P.M.

Before Breakfast 10:30 P.M.

After Breakfast 12 A.M.

Before Lunch 3 A.M.

After Lunch 4:30 A.M.

Before Dinner 8 A.M.

After Dinner 10:30 A.M.

Evening 1:30 P.M.
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